
آشنايي با نرم افزار 
Idrisi Kilimanjaro

دکتر مژگان احمدی



Idrisi

■Idrisi       نرم افزااي  اتزك  زه مزه ر آزوي  رزويز ت نيزا    ي ز

، طراحزي دز   GISر يطي دي تطح  خصصزي دي تز  ا اي دتي ت نيزا 

.اتك

 هيزه  صز تير : اين مرن رزه باز ي  اتزك اي GISمرخي اي ق مليته   ■

   ت توي ت يتتر ، يت  هم ان اي  لايه ه  ت يقوري  ردن داد  ه  ت اي ق مليته

RS نيززا   صزز ي    ياديورتريززد ت ه  تززي ، حززها   ياييتهزز    صززوير

(Filter ) م ييت ي   صوير ت طا ه م     ن يا ري  وان ن م مرد ،.



رط لعه  كClark ير يشگ هه  ديا  رتژ صوي مهافااينرماين■
.دايدقراي

Ron رتفسوي وتط1987ت لديClark ير يشگ هه  ■ Eastman
.د   تيس

Georgeروتسهديتنيرر اچه ياييکيت ير نايناررتي ■ Perkins
Marsh،دانشگ  ديClarkدي مدمهياخود   ي   تم د ري
.كاتداد اختص ص  رپيو ر وتطجغرافي يي ن لياه  فهمت وتعه

 ئوي  يشرفكيري هديياخود   ي    ير يشگ هه ايندانشم  ان يم■
تنيير تر  ن لياه  , صميم شتيا نير ن  ر ط هديGISبمليت

انت  لتقطعيكب مر يريك,يقوري ص تير ردايز, غييرا مي ي يا
.ده  ريان  مف  تي 

Idrisi



در محيط  Idrisiفعال كردن
Window

 يکن           يا  ي ا  رد  ت د مه تمك چپ desktopمرا   تيدن مرن ره ، اي صف ه ■
ين مرن ره اگر نم يه ررموطه مر يت  صف ه ناود ، ريتواني  ا. روس يا دتم ي  ليد   ي  

.يا اي طريق رسير يير مر يت  رونيتوي مي تيي 

■ Start → Programs→Idrisi Kilimanjaro→Idrisi Kilimanjaro 

 وجززه   يزز  ه گزز ري  ززه اي يتز دتم اتززتف د  رززي   يزز ، دي ررحلززه  خززر يت  ■

Unistall Idrisi Kilimanjaro مه هيچ تجه  ليد ن م يي ، چون م بث حزها مرن رزه رزي

.گردد

.د س اي  ليد يت   يکن ررموط مه مرن ره، صف ه يير يت  رونيتوي ظ هر ري گرد■





معرفي مسير داده ها به نرم افزار

. يرد دي امت ا ني ي مه  وده ا  اتك  ه نت يج   ي م ي   دي  ن قراي گIdrisiمرا    ي م  مرن ره 

رجز  اگر دي طي   ي ، احتي ج مه ن شه ت داد  م د  ، ني ي اتك  وده ا  نيا   زك ب زوان ر
ين همچ ز.ت خته دود ت اين اطلاب   دي  ن قرا گرفته ت دي امت ا    ي مه مرن ره رعرفزي دزود 

يس ، دي طي جلس   بملي اين د. خود مرن ره دايا  يکسر  ف يل ه    مد  رويدي ريا د  
داد  رزي دي رواقعي  ه احتي ج مه اتتف د  اي چ ين ف يله يي م د  ، مزه دانشز وي ن  زه ر لايم

. دود 
يا انتخ ب  رد   ه دي نتي ه Data pathت تپس Fileمرا  رعرفي رسيره  اي نواي ر و، 

اين    ر  يا همچ زين رزي .م ي ري دود Project environment   ر  ا    ك ب وان 
.نواي  يکن ه  رش ه    رددي وان م  اتتف د  اي  يکن           

.





آشنايي با آيکونهای نوار ابزار 
ايدريسي

Project Environment       

(File/Data Path: روقعيك دي نواي ر و)
 د  اين    ر  اين ارک ن يا مه   يمر ري ده     رسير داد  ه يي يا  ه مرا   زرتژ  ا  خز ص رزويد اتزتف

ايزن اگر چه داد  ه  يا ري  وان اي هر روقعيتي انتخ ب  رد ار  م  اتتف د  اي.   آيم نم ي  , قراي ري ده  
ودزه دي اين مخا ري  وان يد  وده  ز ي اصزلي ت چ ز   .    ر  اين دتترتي ه   ت ن  ر خواه  مود 

.ر ا  يا  عريف  رد

 وده ه   ر ا   اضز فه رزي Add وده   ي ت اي طريق د مه Browseدي اين    ر  اي طريق د مه 
.دود

امت ا  وده   ي ت تپس Pick Listدي ,  س اي اين   آيم ه گ ري  ه    ر  نم يا داد  ه  م ي ري دود
  ري خرتجي ه   مرن ره مه صوي   يا فرض دي  وده   ي ذخير.  وده ه   ر ا  نم يا داد  ري دود 

ري  وان مه ت ير رسيره  Browseاي طريق د مه , بلات  مراين رسير ه  Pick Listدي    ر  . دود 
.نيا دتترتي دادك



Idrisi File Explorer

(File/ Idrisi File Explorer: روقعيك دي نواي ر و)■

امااي  ر  تب يا مرا  ر يريك ترش ه    م م ف يل ه   روجزود  دي فررتهز   رت زوی اي ييسزي■

. فراهم ري  تيد 

. امااي  ر  تب يا مرا  ر يريك ت رش ه    م م ف يله   روجود دي اي ييسي فراهم ري  تيد■

:مرخي اي  وان يي ه   اين امااي با ي    اي■

حها ت ج م  يي, پي ,  غيير ن م ■

نم يا لايه ه   يتتر  ت ت توي ■

نم يا فهرتك ف يله   روجود دي  وده ه     ي ت ر ا ■

ت تزوي  ت ف يزل هز   اييز دي رت ديتز  , رش ه   ف يزل تز   ررمزوط مزه ف يزل هز   يتزتر ■

(Metadata)



Metadata

(File/ Metadata: روقعيك دي نواي ر و)■

, رش ه   ت تيرايا ف يزل تز   ررمزوط مزه ف يلهز   يتزتر , اي اين امااي مرا   اي  د ■

رشز ه   ت , ضزمن  نکزه اي  ن مزرا  اي ز د. ت توي  ت اييز خصوصي   اتتف د  رزي دزود

.نيا اتتف د  ري دود.(ref)تيرايا ف يل   يارتره   تيستم ررج  



Display  

( Display/Display Launcher: روقعيك دي نواي ر و)■

.مرا  نم يا  صوير مک ي ري يتد■



Symbol Workshop 

(/Symbol Workshop Display:روقعيك دي نواي ر و )■

ي دود اي اين دتتوي مرا  اي  د ت اصلاح ف يل ه    لك ت تمال دي اي ييسي اتتف د  ر■

مز  خطزي ت  لزي گزوني مزه  ر ييزب, ن طزه ا  , ف يل ه   تمال مرا  ف يل هز   رت زي . 

.ذخير  ري گردن sm0 ,.sm1,sm2 .,.smt. سون ه   

دي    ر  ايزن دتزتوي اماايهز يي مزرا  . ذخير  ري دود smp.م   سون  Palleteف يل ■

جزود  پي  ردن ت ي  ديتن ي مي خصوصي  ي رثل ينگ تان اي  دي د خص ه   تزمال نيزا ت

.دايد



ابزارهای بزرگنمايي 

همرا مه هدودريداد نم يالايهFrameي چه يچوبيدديا ن شهلايههر■
هن ش   ر دي(...تر ي س,ياه م ,دم لجهكرثل)ن شه ر يباجاا ت ير
.گيرن ريقراي

اي   ر , نروقعيك غييرت   ر رريه  ديروسنش نگردادنقرايم  وانري■
.نمود  آيمان اي ح ا ثرديي تدادان اي  غيير



Fit Map Window to Layer 

Frame  

اتتف د  اي امن امااي روجب ري دود  ه چ يچوب لايه    ح  يي د  مزه چز يچوب ن شزه■

. ناديد گردد

 س اي  غيير ان اي  چ يچوب لايزه دي يرز ني  زه چز يچوب, اين  ه اين امااي "خصوص ■

.ي گيردج ي  لايه دکل ر  تاي مرا  نگه دادتن لايه ن ادته م د  رويد اتتف د  قراي ر



Maximize Display of Layer 

Frame  

ثر اتتف د  اي اين امااي ر  ر مه اين ري دود  ه    ر  ن شه ت چز يچوب لايزه دي حز ا ■

. ان اي  خود قراي گيرن  

.دي صف ه  لي  هم اين بمل يا ان  م ري ده End لي  ■



Zoom Window 

ح لكايندي هنمود  ليد يکنيت امت ا، صويرايمخشي ردنمايگمرا ■
. ي ريديفع لح لكمهتد  فع لنم رک ن

ح لكديروسچپد مه هطويهم نت رد  ليدنآررويدر  تد طرايدمر■
اي ست رد حر كدرتین طهر  ملگودهطرامه،اتك  يينتمكمهفش ي
.دودرييه روسر  تد  عيين

ديوان ريياه  يکسلصوي اينمه ه رد کراي وانريم يچ  ينيا  ياين■
.نمودرش ه  يتتر  ص تير



Restore Original Window    

خزود اين  يکون ر  ر مه اين ري دود  ه    ر  ن شه ت چ يچوب لايه مه ان اي  اتليه نم يا
.دي صف ه  لي  هم همين ق ملاك يا دايدHomeاتتف د  اي  لي  . مرگردد

  بمل  وچد تمايگ نمودن  صوير يا همچ ين ري  وان م  د مه هز   روجزود دي    زر
Composerم  د مه ه      ي   ن نيا ري  وان  صوير يا ج م    رد . ان  م داد.



Feature properties  

(File/ Metadata: روقعيك دي نواي ر و)■

اين امااي ارک ن رش ه   اييده    مز م لايزه هز   روجزود دي يزد گزرت  يا مزرا  هزر ■

.روقعيك رک ني ت دي يد ير ن  فراهم ري     



Digitize

(File/ Metadata: روقعيك دي نواي ر و)■

.مرا  يقوري  ردن  صوير مک ي ري يتد■



Delete feature

(File/ Metadata: روقعيك دي نواي ر و)■

 ب انتخز, اين امااي ارک ن ري ده   ه بوايض ت توي  رويد نآر يا اي لايه ت توي  فع ل ■

ه مرا  حها بوايض امت ا مر اين  يکون  ليد  رد  ت تزپس ب يضزه ا  يا  ز. ت حها  رد 

. قص  حها  ن يا دايي  انتخ ب نم يي  

دي صزف ه Deleteدي اين ح لك ينگ ب يضه قررا د   ت تپس مرا  حها  ن اي  لي  ■

. لي  اتتف د    ي 



Save Digitized Data  

(File/ Metadata: روقعيك دي نواي ر و)■

.مرا  ذخير  داد  ه   ت توي  ح صل اي يقوري  ردن اي اين امااي اتتف د  ري دود■

.  ديع ي ب يضه ا  مرا  ذخير   ردن تجود داي, ه گ ري  ه اين  يکون قررا ينگ اتك ■

ه ذخير   يغ ري ياج  م,اگر قال اي ذخير   ردن لايه يقوري د      ر  ن شه مسته گردد ■
. غييرا  ان  م د   دي لايه رويد نآر  ظ هر ري دود



Histogram Display  

 , GisAnalysis/Database Query/HISTO: روقعيزززك دي نزززواي ر زززو)■

Display/HISTO )

ه   نشز ن اين  يکون هيستوگرام فراتاني اييز تلوله  يا مرا  ف يل ه    صوير  ت ف يل■

عز اد مرا  اي  د هيستوگرام اي   سيم ر  تد  داد  ه  مزر بزرض يز   . طيفي  هيه ري     

 مزل ان راا رعي ي ت ر  تد  داد  ه  نيزا ق, ضمن  نکه ري نگين .  لاس ه  اتتف د  ري دود 

نوی نمودايه  نيزا مزه . مرا   ن دت نوی خرتجي نموداي  ت ب د  تجود دايد . رش ه   اتك 

ارکز ن نمز يا نمودايهز  مزه صزوي  . نواي  ت رس حتي ق مل نمز يا اتزك , صوي  خطي 

.  معي ت غير   معي نيا اي ديگر ق مليته   اين امااي اتك



Image Calculator  

(GisAnalysis/Database Query/Image Calculator: روقعيك دي نواي ر و)■

امااي ر ل ت ي  يي ضي اتك  ه ارک ن تايد نمودن ر ل مه صزوي  رعز دلا  جازر  ت ■

.ر ط ي فراهم ري ت يد 

 Mathematical)دت نززوی اي رعزز دلا  ق مززل اجراتززك  ززه دزز رل رعزز دلا  يي ضززي ■

Expressions ) ت رع دلا  ر ط ي(Logical Expressions ) ري م د .



Reclass

(GisAnalysis/Database Query/RECLASS: روقعيك دي نواي ر و)■

, تر  اي اين دتتوي مرا  طا ه م    ت ي  طا ه م    ر  د اييز تلوله    صوير يتز■

مز  طا زه م ز   اييدزه  دي ف يلهز  . بوايض لايه ه   ت توي  اتتف د  ري دودIDاييز 

. تيتد  ف يله   خرتجي ج ي  م تك ري  ي 

ار  اييز ه   خرتجي , ر  تد  اييده  يا م ي  اي  ص تير ت ف يله   تيتد  م تك  تيد ■

طا زه م ز   مزر اتز س فواصزل. يا م ي  مه صوي  ر اا ت مه صوي  اب اد ص يح تايد نمزود

يرد رس ت  مين ر  تد  داد  ه  تي   وتط ر  تد  ه    عريف د    وتط   يمر ان  م ري گ

 ن اييز مز تن , دي صوي  اتتف د  نش ن يد اييز ف يل تيتد  دي يرز ن طا زه م ز   . 

(.1) غيير م قي خواه  ر ن 



تصويرنمايش 
Display

(روقعيك دي نواي ر و :Display/Display Launcher )

ود  ه مرا  نم يا ن شه ه ، بکس ه  ت ت ير اطلاب    صوير ، اي اين دتتوي اتتف د  ري د
.دي نتي ه    ر   ن م ي ري گردد

اين    ر  همچ ين م  اتتف د  اي  يکن                   رش ه   ري دود.



:دي اين    ر  انوای ف يل ه    صوير تجود دايد  ه م ي  يکي اي  نه  انتخ ب دود ■

-Raster layer :  دي داد  ه    يتتر  ، ذخير  اطلاب   مر ات س تلول يز   يکسزل هز

.ري م د  

-Vector layer : ت خت ي داد  ه  ، ف ق  يديف تي  تتون ري م دز  تلزي دايا   و ولزوژ

.اتك 

تصويرنمايش 
Display



-Map composition file : داد  ه   ر هواي  ا  لايه ه   اطلاب  ي  د م ن  اتزك  زه

 ياي خوانز     يمر ري  وان  اي  نه  اتتف د   رد  ت ص تير   هيه      ه م  م  ص تير  ر

. ري دود ت اين  ص تير   ي   رويد نآر يا مهتر نش ن ري ده 

نمز  گ هي تيرايا ه يي يت   صوير ان  م ري دود اي قايل اض فه  ردن جهكهمچ ين -

ايزن , ود  صوير مسته دز, داکه تغير   ه اگر م تن ذخير   ردن دي اي ييسي, ر ي س, 

.تيرايا ه  يا ديگر م ي نمي  وان دي  

يا مز  مرا  اي که متوان ر  د  ن يا دي اي ييسي م ي  رد م ي   زس اي ا مز م تيزرايا  ن-

 Displayذخير   رد ت مرا  رش ه   ر  د دي    ر  map composition fileفررك 

lanture امت ا قسمك تومFile typeيا فع ل  رد  ت  صوير ج ي  يا نم يا داد.

تصويرنمايش 
Display



آننمونه هایی ازتصاویر رستری و مشابه وکتوری



ه درسمت چپ پنجربرای وارد کردن نام نقشه روی 
.             یدکلیک کرده و سپس نقشه مورد نظر را انتخاب نمای



 دي تمك ياتك اين    ر  همچ ين انوابي ر  تد ايPalette دي   ريشود  ه مزر اتز س
وير اي مين اي ييسي م  مريتي ياه م  ت داد  ه    ص.  ن ينگ ن شه مطوي رست يم  غيير ري    

يکي يا مرا  نم يا لايه انتخ ب ( Qualitative) ت  يفي ( Quantitative) دت  لك  مي 
.  ه ني ي  مه انتخ ب  لك مرا  نم يا ن اين ( RGB24)غير اي  ص تير  ر ياي , ري     

          ن  ودزه دي   يين    ر  تمك ياتك ت مز ي  زردم يه اين ف يله  يا ريتوان م   ليد يت
/Idrisi Kilimanjaro/symbols/ رش ه    رد.

 س اي انتخ ب  لك رويد نآر ، ل    ر  يا ok رد      صوير نم يا داد  دود .

  م  نم يا  صوير ت همرا  م   ن ،   رComposer ايزن    زر  دايا  د مزه .م ي ري گزردد
.ه يي اتك  ه اي طريق هر   ام ابم ل خ صي يت   صوير ري  وان ابم ل  رد





 مزه  غييزر ينزگ لايم م دز  ، مز   ليزد مزر د (  س اي نمز يا  صزوير )اگر دي اين ررحله
Layer properties ززر   ن يا مزز ي  ززرد  ت دي قسززمك    ،Palette File     اي طريززق

.ينگ رويد نآر يا مه طري ي  ه قالا گفته د  ،  غيير دهي 

  م ي   وجه دادك  ه  غييرا ي  ه اي طريق    رComposer  ابم ل ري دود   هز  يت
.ن شه ا  ان  م ري  هيرد  ه فع ل م د  

  دي    رLayer Properties همچ ين ري  وان اطلابز   ييز د  ياجز  مزه  صزوير
ون م تك نم يشي اي جمله ن م لايه ، نوی ، تيستم  صوير ، ر  تد   صوير ،  ع اد يديف ت تت

. تيد 
 همچ ين اي طريق د مهHistogram  دي اين    زر  رزي  زوان اطلابز   ن شزه يا مصزوي

.نموداي رش ه   نمود
ت م  اتتف د  اي روس ت حر ك رک ن نم  يت   صوير ري  وان اطلابز  ي نآيزر بز د يديزف

ت بلات  مر  ن م  اتتف د  اي  يکن. تتون ت رختص   جغرافي يي هر ن طه يا مه دتك  تيد 
. ليد يت  ن شه ري  وان ب د  يکسل يا نيا دي  ن ن طه رويد نآر رش ه    رد 



 اطلاب    صوير ابزم اي طزول تبزرض جغرافيز يي ، يديزف ت تزتون ت بز د  يکسزل يا

Propertiesت    ر  Feature Propertiesهمچ ين ري  وان اي طريق د مه 

.رش ه   نمود

طزه  ه الاته م ي  رک ن نم  يا م   ليد يت   يکن            فع ل نمزود  ت تزپس دي ن 

. دلخوا  يت  ن شه  ليد  رد 

 مه اين صوي  رشخص   ذ ر د   دي ج تلProperties ثاك ري دود.



مديريت داده ها

ت Fileمرا  حها ت  پي  ردن لايه ه  ت نيا رش ه   ت ير ت خت يه   لايه ه  اي ر و

ردد اتتف د  ري دود ه م ين  ر يب    ر  يير م ي ري گIdrisi File Explorerدتتوي

.دي ضمن اين    ر  يا ري  وان م   يکن                            نيا رش ه    رد. 





يد دي اين    ر  امت ا دي جعاه م لا  تمك ياتك ، ف يلي  ه رش ه   اطلابز    ن رزو■

دي تمك چپ    ر  ، نوی File typeنآر اتك يا اي طريق    انتخ ب  رد  ت تپس اي طريق 

. ف يل رشخص ري دود 

.مرا  انتخ ب يد ف يل ، م  روس يت   ن يفته ت  ليد نم يي  ■

. اتتف د  ري دود Select Allمرا  انتخ ب  م م ف يله  اي د مه ■

هز  يا ف يله يي يا  ه قالا انتخ ب د   اي ح لك انتخ ب خ يج ت م يزه ف يلInvertد مه ■

. انتخ ب ري     



طرز كپي كردن يك فايل 

 ليد Copy selected itemف يل رويد نآر يا انتخ ب  رد  ،تپس يت  د مه ■

.  رد   ه دي اين ه گ م    ر  يير م ي ري گردد 

.يد  ري دود Save، ف يل ر ص  يا انتخ ب نمود  تمع   د مه Save inدي جعاه ■



حذف فايل 

.يا  ليد   ي  Deleteمرا  حها يد ف يل امت ا ف يل يا انتخ ب  رد  تتپس د مه ■



تغيير نام يك فايل 

يا انتخ ب  زرد  Renameمرا   غيير ن م نيا امت ا ف يل يا انتخ ب  رد  ت تپس د مه ■

تايد  زرد  ت File nameنز م ج يز  يا دي جعازه . م ي دزود Enter a new name      ر  

.ذخير  نم يي  

 Viewهمچ زين  د مزه هز    ديگزر   اي قايزل Idrisi File Explorerدي    زر  ■

Structure , View Binary , View Metadata , Display Layer تجود دايد  ه:

-Display Layer :  مرا  نم يا  صوير انتخ ب د

-View Metadata : مرا  دي ن اطلاب    صوير

-View Structure :گدي ن اطلاب    صوير مه صوي  ب د مرا  هر  يکسل مه ج   ين

-View Binary : ل مه مرا  هر  يکس( صفر ت يد ) دي ن اطلاب    صوير مه صوي  ب د

ج   ينگ



ورود داده ها به سيستم 

:مرا  تايد  ردن اطلاب   ن شه ا  مه تيستم ياهه   يير تجود دايد■

اتتف د  اي دتتگ   يقوري گر -■

ي اتتف د  اي   غه ه   رشاد ت خوان ن اطلاب   ت تايد  ردن  ن مطوي دتتي م  صف ه  ل-■

رعرفي  ن , ت غير  BMP ,.JPEG,.TIF. ولي  ف يل  صوير  م  فررته  , اتتف د  اي اتک ر -■

دي نرم افااي ت يقوري  ردن  ن مطوي دتتي 

رعرفزي ت خوانز ن , ت غير  BMP . ,.JPEG,.TIF ولي  ف يل  صوير  م  , اتتف د  اي اتک ر -■

ت تپس انت  ل R2V ن دي نرم افاايه يي  ه يقوري  ردن يا مه صوي  ا ور  يد ان  م ري ده   رثل 

.ر ن   اي ييسيGIS ن مه نرم افاايه   



ورود دستي داده ها 

مم آزوي . اتکن  ردن ن شه هز   روجزود اتزك GISيکي اي ياهه   تيتد داد  ه  مه ■

BMP.، رعمولا اين ن شه ه  يا م   سون  Idrisiاتتف د  ن شه ه   اتکن د   دي نرم افااي 

. اسكن مي نمايندgrayscaleت مه صوي  TIF.ت ي  

ر ن ييزر مطوي رست يم نمي  وان  اين ف يله  يا مخوان  ت م ي   ن يا  طاق فرIdrisiمرن ره ■

. رد Importمه مرن ره 

■File → Import → Desktup Publishing Formats → GEOTIFF/TIFF

:م ي ري گردد GEOTIFF/TIFFدي اين صوي     ر  ■



. رک لم      ر  يا مه دکل فوق ان  م داد  ت  ن يا اجرا   ي  

الاته , د ح ل اي اين  صوير ري  وان مه ب وان ن شه   يه مرا  بمل يقوري  ردن اتتف د  نمو

.گرددGeorefrenseمهتر اتك قال اي  ن اين  صوير يرين ررج  ي  



(  Digitize)رقومي كردن تصوير 
م ي گردد   digitizeم ين ر آوي  يکن            يا دي نواي امااي  ليد نمود        ر 

.اجرا نم يي  okرک لم      ر  يا مه صوي  فوق   رل  رد  ت دتتوي يا م   ليد مر ■

.دي اين ح لك رک ن نم  مه دکل فع ل دي ري  ي  ■





 اي امت ا  خط  و وگرافي  ه ب د اي ف بي  ن يا مزه صزوي   ز  تايد نمزود  ايزم بمزل
ي يقوري  ردن يا م   ليد رتوالي د مه تمك چپ روس ت حر ك يت  خزط  و زوگراف

. اداره داد  ت دي انته  د مه تمك ياتك روس يا  ليد   ي  

دمهتر اتك دي اين ير ن ن طه رويد نآر يا م  اتتف د  اي  يکن               ذخير  نمو.



يا فع ل  رد  ت    ر  مع   يا دي Digitizeمرا  يقوري  ردن خط مع   دتم ي   يکن 

:يا رش ه   نم يي  Digitize  يي   رد     دتم ي     ر  Addقسمك 

. ، غير فع ل اتك ID or Valueدي اين ررحله اين    ر  دي همه قسمته  مه جا جعاه ■

وط م ين صوي  ب د اي ف بي مع   يا تايد ت دتتويا  يا ر ن   قال اداره دهي      مز م خطز

. و وگرافي يقوري گردد 



س اي اگر مع  اي يقوري  ردن رتوجه ادتا هي دوي  ، امت ا اطلاب   يا ذخير  نمود  ، تپ

. طريق  يکن                رک ن نم  يا فع ل نمود  ت يت  خط ادتا    ليد   ي 

 دي اين ه گ م    ر  ا  م ي ري دود  ه اي دم  دي رويد حها توال ري     ، دي صوي

دي نه يك  زل خطزوط يقزوري .   ي  okيت   ي مويد يا يد  ت Delete  يي  د مه 

د   ي م  اتتف د  اي  يکون              ذخير    ي 



تر تبديل لايه رقومي شده به لايه رس

:يتتر   ردن يد لايه ت توي دي دت ررحله ان  م ري گيرد ■

ن  هيه يد ق لب خ لي مر ات س ن شه ا   ه بمل يقوري  زردن  اي يت   : ررحله اتل ■

.ان  م گرفك 

:    م ي ري گردد Initialم ين ر آوي طاق فرر ن يير ،    ر  ■

Data Entry     →                Initial 



مرا   هيه ق لب خ لي يتتر  ري  وان مر ات س اطلاب   روجود  اي دت يتز 

.اتتف د   رد



استفاده از دستور
Copy Spatial parameter

 ه اي يقوري  ردن دتتي  صوير اتکن د   topolineمرا  يتتر  نمودن لايه ■

Map ح صل د  ري  وان اي دتتويCopyاتتف د   رد  .

يا فش ي دهي     okم ين ر آوي  س اي  ر نمودن رک لم      ر  مصوي  يير د مه ■

.دتتوي اجرا گردد 



.اي  د ري گردد (  صوير خ لي )دي اين ير ن يد ق لب خ لي ■

.  ، رش ه     ي  Displayاين  صوير يا ري  واني  اي طريق دتتوي ■



.رک لم   يا مه صوي  فوق  ر نمود  ت تپس دتتوي يا اجرا   ي  

.د    دي اين ق لب خ لي Digiteييختن اطلاب   : ررحله دتم ■

: م ي گردد linerasم ين ر آوي رسير يير يا طي  رد        ر  ■

■Reformat → Raster / Vector Convertion → LINRAS 



استفاده از دستور
Define Spatial parameter

. رداتتف د Liner2vلايه ردنيتترمرا  وانريرث لطويمهدتتويايناي■

Layerد مهتComposer   ر ايياLiner2vلايهاطلاب  م ي امت ار آويم ين

Propertise  دوداتتف د خ ليق لب تيدنم تكمرا  ناطلاب  اي  نمودرش ه.

. ر  ي ييرصوي مهياInitial   ر ■



ت معزز  د مززه                                                             يا يد  ت مزز   وجززه مززه ■

.   ر  م ي د   مه صوي  يير  ر ري دود , Liner2vاطلاب   لايه 



. مرا  اب اد ررموط مه ر  تد  ه    صزوير رزي  زوان ابز اد ينز   يا دي نآزر گرفزك ■

:همچ ين  ع اد يديف ت تتون يا ري  وان اي فررول يير م تك  تيد 

solution

MinXMaxX
Columns

Re




solution

MinYMaxY
Row

Re






س دي اين مخا  چون ر ط ه يکي اتك ري  وان هم ن داد  ه يي  ه دي ررحله ژئويفرن■

.   ردن اتتف د  د يا مک ي مرد

 زرد  ت رزي  زوان ق لزب okيا Initial س اي تايد  ردن اطلاب      ر  م لا ت    زر  ■

.رش ه   نمودDisplayخ لي يا اي طريق دتتوي 

.اجرا ري دودReformatررحله دتم يتتر  ردن  ف ت ي م  قالي ن ادته ت اي دتتوي ■



Windowدستور 

تجود چون دي  صوير يتتر  اي  د د   اطراا  صوير تي   ينگ مود  تخطوط اي ف بي■

ادزته ن ايد ، همچ ين رمکن اتك خط     يمر نيا دي يقوري  ردن ن شه  و وگرافي تجود د

، اي  صزوير Demقال اي  هيه ن شزه "م د  اي جمله نرتي ن خطوط مه انته    صوير رعمولا

.گرفته ري دود Windowيتتر ، يد 

.اض ف    صوير يا مرز ري ين Windowدتتوي ■

:اينواي دتتويه  رسير يير يا اجرا ري دود Windowمرا  اجرا  دتتوي ■

■Reformat → Window



ط مزه دي    ر  م لا ، مه ج   چه ي رستطيل تفي  تمك ياتك ، مه  ر يب ابز اد ررمزو■

دي م لا   صوير يتتر، تمك چزپ ت همچ زين ابز اد Windowتتون ت يديف ن طه درتی 

دي   يين  صوير ، تمك ياتزك يا تايد رزي Windowررموط مه تتون ت يديف ن طه انته يي 

.  يم 



ريتوان   م  انتخ ب گاي ه Windowبمل . اجرا ري   يم OKتپس دتتوي يا م  يدن د مه 

مرات س ح اقل تح ا ثر طول ت برض جغرافي يي ت م  انتخ ب                          

مر ات س ق لب يد  صوير رويد نآر ان  م دود  ه دي اين 

ي صوي  م    دم ي  يديف ت تتون گاي ه ه   طول ت برض جغرافي يي ت ي  تيتد ن م  صوير تايد  ر
.دود



از لايه رستري Demتهيه نقشه 
اي خطوط  و وگرافي ، امت ا رسير ييزر يا طزي  زرد   ز     زر  Demمرا   هيه ن شه ■

Interconم ي گردد.

■Analysis → Surface Analysis → Interpolation → Intercon



دي چه يجعاه تتطي ، ابز اد اي فز بي  زه اي  .رک لم      ر  يا مه صوي  م لا  ر  رد■

ي خط  راي اي يکزي اي گودزه هز  نمز"اگر دقي  . قراي ري گيرد, چه ي گوز ن شه ري گهيد 

 ن اي ب د اي ف بي يا  ه احتمز ل گهدزتن, گهدك م   وجه مه  اب اد اي ف بي ناديد گوده 

طزوط نيزا  ه اين   ي يا ري  وان م  ديتن ي مي مزين خ, گوده ميشتر اتك گهادته ري دود 

.ان  م داد 

 يز  مرا  رش ه   نتي ه   ي ، م  مر ح م  ن لياهز  م. يا  ليد نم يي  okتپس د مه  ■

. دق ي ي صار نمود 



تهیه نقشه طبقات ارتفاع 

 ه دي ر له قازل  هيزه دز  ، ن شزه  يوتزته   اي اي فز ی ر ط زه اتزك Demن شه ■

  ري دزود ،مطوييکه اگر م   يکن د  ته دي هر ج يي اي ن شه  ليد دود ،اي ف ی  ن ن طه داد

 ع اد طا    .طا ه م    دود Demمرا   هيه ن شه طا    اي ف ی   في اتك   ه  ن شه . 

ر ار  مرا  اي  د دار ه ه  م يز  مزه حز اقل ت حز ا ث. ت دار ه  ن مسته مه ه ا رتف ت  اتك 

 mapايزن اييدزه  يا رزي  زوان دي    زر  . دقزك  زرد Demاييده   اي ف بي دي ن شزه 

properties مطوي رث ل  صوير . رش ه    ردDem رتر يا 1995   700ر  اييز اي ف بي اي

. دايد 

:فرض   ي  ري خواهي  ن شه ا  م  طا    اي ف ی يير  هيه   ي  ■



:يا م ي  ي  Reclassم ين ر آوي طاق فرر ن يير    ر  

Gis Analysis → Database Query → Reclass

اي ف ی اي تطح ديي طا   

11000-700

21300-1000

31700-1300

4>1700



.اين    ر  يا همچ ين ري  وان م   ليد يت   يکن                    رش ه    رد ■

.رک لم   يا رط مق م لا   رل نمود  ت ن يا اجرا   ي  



تهيه نقشه طبقات شيب 

، ن شه  يوتته ديب يا  هيزه نمزود  Demمرا   هيه ن شه طا    ديب امت ا اي ن شه ■

.تتپس اي اين ن شه ن شه طا    ديب  هيه ري دود 

:م ي گردد Slopeرسير يير ياطي   ي        ر  Slopeمم آوي رش ه      ر  ■

■Gis Analysis →Surface Analysis → Topographic Variable → Slope



.رک لم      ر  يا رط مق م لا   رل نمود  ت دتتوي يا اجرا   ي  



ي  اي دتتوي دي ررحله مع  ، مرا   هيه ن شه طا    ديب اي اين ن شه  يوتته ديب م ■
يير جهك طا ه م    اين ن شه ري  وان اي طا ه م   . طا ه م    اتتف د   رد 

.اتتف د   رد 

درصد شيبطبقات

18-0

215-8

330-15

30بيش از 4

يب مرا   هيه ن شه طا    ديب نيا م يز  مزه حز اقل ت حز ا ثر اييز دزيب دي ن شزه دز

. يوتته  وجه گردد ت دار ه طا    مر ات س  ن   آيم دود





تهيه نقشه طبقات جهت 

، ن شه  يوتته جهك يا  هيه نمزود  Demمرا   هيه ن شه طا    جهك  امت ا اي ن شه ■

.تتپس اي اين ن شه ن شه طا    جهك  هيه ري دود 

:م ي گردد Aspectرسير يير ياطي   ي        ر  Aspectمم آوي رش ه      ر  ■

■Gis Analysis →Surface Analysis → Topographic Variable → Aspect



.رک لم      ر  يا رط مق م لا   رل نمود  ت دتتوي يا اجرا   ي  



ن اي دت دي ررحله مع  ، مرا   هيه ن شه طا    جهك اي اين ن شه  يوتته جهك ري  وا■

. دتتوي طا ه م     ييراتتف د   رد 

■

:طا ه م      ج جهته ■

طبقاتدامنه طبقات

01-1F

4502N

3603152N

135453E

2251354S

3152255W



:طا ه م    نه جهته 

دامنه طبقاتطبقات

0F01-

1N3605/337

1N5/220

2NE5/675/22

3E5/1125/67

4SE5/1575/112

5S5/2025/157

6SW5/2475/202

7W5/2925/247

8NW5/3375/292



.يا مرا  مهتر د ن فيلتر نم يي  Reclassري  واني   ص تير ح صل اي 



فيلتر
■Filterي دتتوي  اتك  ه  صوير  ج ي  اي يد  صوير تيتد  اي  د رزي   ز   زه د

   صوير ج ي  يقم هر  يکسزل مزر اتز س ايقز م  يکسزل هز   جز ناي  ن دي  صزوير تيتد

ايد اي فيلتر لکه ه    وچکي يا  ه دي طا    م  تزطح مايگتزر تجزود د. ر  تاه ري گردد 

.ه  دادكمين ري مرد ت دي نتي ه ن شه  لفي ي  ع اد تاح  ه    متر ار  يک تك  ر يا خوا

ه دي  ع اد  يکسل ه يي  ه دي نوی فيلتر ديگير ري دون  ، مزر اتز س ايقز ري اتزك  ز■

دي صزوي يکه رزثلا . 7*7تيز  5*5، 3*3: مه طوي رث ل . ر  ريس ه   انتخ مي قراي داين  

ه ، انتخ ب دود ، داد  ه   نه  يکسل دي ر  تاه تايد ري دود ت ب د نه يي م3*3ر  ريس 

. يکسل ري ني داد  ري دود 

:  س اي اجرا  فرر ن يير ،    ر  فيلتر ري  ي  ■

■Gis Analysis / Context Operator / Filter                                              



ره  ري  وان  فيلتره   رختلفي يا ري  وان يت   ص تير يقوري اجرا نمود ، هر چ    ه نت يج اين فيلت

.م  هم مسي ي رتف ت  م د  ، ار  همگي دايا  يتز اجرا  يکس ني هست   

دي  ص تير م تزك Modت Mean ,Minimum ,Maximumم ليل اتتف د  ميشتر  فيلتره   

. وضي    ميشتر  دي رويد اين فيلتره  داد  ري دود,  ر    

غير  اجرا رزي ن شه  يوتته ديب ت, يت   ص تير  يوتته رثل ن شه  يوتته اي ف بي Meanفيلتر 

.اين فيلتر يت   ص تير طا ه م    د   نا ي  اجرا دود. دود



.  رفتزه دزودمرا  دانستن اي که چه نوی فيلتر  اتتف د  دود م ي   ل  صزو  دي نآزر گ■

اي فيلتزر , اگر لکزه ا   زه م يز  حزها دزود دايا  دزم ي  طا زه مز لا ر  اي يري زه م دز  

Minimum ت اگر دم ي  طا ه لکه اي يري ه  متر م د  اي فيلتزرMaximum اتزتف د  رزي

.اتتف د  دود Modاگر  صوير  هردت نوی لکه يا دادك م ي  اي فيلتر . دود

 ز مراين م يز  م. م ي  دانسك  ه انتخ ب فيلتر ادتا    يفيزك  صزوير يا مز  ر رزي   ز  ■

.انتخ ب فيلتر ديتك ت م  احتي ط صوي  گيرد 



تهيه راهنما 

: م ي گردد Metadataمرا   عريف ياه م  ، امت ا رسير يير يا طي  رد        ر  ■

دي اين    ر  مم آوي اض فه  ردن يديف ه يي مرا   عريف ياه م  اي د مه                               ■

.مه ايا  هر م ي فش ي د مه يد يديف اض فه ري دود . اتتف د  ري دود 



.  ي  Saveدي    ر  Fileرک لم   لايم يا ان  م داد  تاي طريق ر و 



زمين تلفيق نقشه ها و تهيه نقشه واحدهای اكولوژيکي

فيزق ،  ل: مرا   لفيق ن شه ه  دي اين مرن ره ديو  هز   رختلفزي تجزود دايد اي قايزل■

. ن شه ه  م  دت ديو  ان  م گردد 

CrossTabدتتوي -1■

اتتف د  اي فررول-2■

يتز مولين-3■



CrossTabتلفيق از طريق دستور 

:رسير يير ياطي   ي        ر   ن م ي گردد Cross Tabمم آوي رش ه      ر  ■

■Analysis → Database Quary → Cross Tab

.دي ررحله اتل ن شه اي ف ی ت ديب يا  لفيق   ي  -■



. رک لم   يا ان  م داد  تدتتوي يا اجرا   ي  
.ي  دي ررحله دتم ن شه  لفي ي ح صل اي ررحله اتل ت ن شه جهك يا م  هم  لفيق نم ي-



. رک لم   يا ان  م داد  تدتتوي يا اجرا   ي  
ديب ت جهك , يا م  ن شه ه     يه طا    اي ف ی Crosstab2دي ررحله مع  ريتوان ن شه 

.دي يد گرت  قراي داد     متوان اييده   تاح  ه  يا دي چه ي ن شه م  هم رش ه    رد



گروه بندی لايه ها 
وده  ز ي امت ا م ي   وجه دادك  ه هر چه ي ف يل  صوير  ه ري خواهيم دي يد گرت  قراي گيرد م ي  دي  ■

.وداگر ف يل ن شه ا  حضوي ن ادك م ي  اي  وده ررج  مه ديتن  وده   ي  پي د. تجود دادته م د 

.مرا  گرت  م    لايه ه  مه طريق يير بمل ري دود■

■

.م ي گردد Collection Editorامت ا رسير يير يا طي   ي        ر  ■

■ File → Collection Editor

يا انتخ ب  رد  ت ن ري مرا  گرت  ف يله  م هي   ت  س اي  ن New   ر  گاي ه Fileتپس اي ر و ■
,دي جعاه م ي د   ف يل ه  يا م  اتتف د  اي گاي ه . يا  ليد   ي  Openد مه       Insert before م   وجه

Saveت دتتوي Fileمه  ر يب رويد ني ي دي ر ل تايد جعاه تمك ياتك   ي  ت دي نه يك م  اتتف د  اي ر و 

.  داد  ه  يا ذخير  نم يي  





ا م  يا اجرا   ي  ، دي يديف ف يله  ري  واني  ن م ف يل گرتهي يDisplayح ل اگر دتتوي ■

. يا نم يا دهي  Cross2  في اتك اي اين ف يل ن شه . بلارك رثاتي دي    ي  ن ماي ي  

يا Feature propertiesد مزهComposer زس اي  دزک ي دز ن  صزوير اي    زر  ■

.  ليد   ي        ر   ن م ي دود 

ا ح ل م   ليد يت  هر   ام اي تاح ه   ا ولوژيکي ، دم  ري  وانيز  تز ير اطلابز   ي■

ه ماي ي  ت م   وجه مه ر ل ايائه د   ، رشخص   يز   زFeature propertiesنيا دي ج تل 

. هر تاح  ا ولوژيکي مرا    ام   يمر  ر  تب تمه   ام طا ه اختص ص دايد 



ه آماده سازی نقشه و باز كردن آن در يك برنام
ديگر 

هيه مرا  ن شه نه يي  ه اي يتنا    ر ط ه م تك  ر  ، ر ي س ، جهك نم  ت  يتر  ■

د مه Composerم ين ر آوي اي    ر  . نم يي  

. يا فع ل  رد        ر   ن م ي گردد تي  يت   صوير  ليد ياتك ان  م ري دهيم 



مزه  ر يزب مزرا  اي ز د  Titlesت North Arrow ،Scale Barدي اين    ر  د مه هز   

.جهك نم  ، ر ي س ت  يتر دي  صوير مک ي ري يتن  

اي طريق اين د مه ه  ن شه يا  ر د  ت ي   رد  ت تپس  ن يا اي طريق د مه
ذخير  نم يي . BMPم   سون  Composerدي    ر  

.



يا م ي نمود  ت تپس اي طريزق فررز ن ييزر    زر  WORDح ل ري  واني  مرن ره ديگر  رثلا 

Insert Picture  يا م ي   ي.

Insert → Picture 

Insertتپس دي    ر  م ي د   رسير نت يج داد  ه  يا رعرفي نمزود  ت  صزوير رزويد نآزر يا 

.  ي  



Displayمه اين  ر يب ري  وان  صوير ذخير  د   يا دي خود مرن ره اي ييسي ت اي طريق دتتوي 

يا فع ل  File typeامت ا قسمك توم Display Luntureم ين ر آوي دي    ر  . رش ه    رد
.ري  وان ن م ن شه يا رش ه   ت نم يا دادBrowse رد  ت تپس اي طريق 



تعيين مساحت
وع برای تعیین مساحت کاربری ها در یک نقشه کاربری اراضی یا هر ن■

:  مساحت دیگری از دستور زیر استفاده میشود

■ Analysis\Database Query\AREA



:دکل يير خرتجي نرم افااي اي رس حك   يمر  ه  يا نش ن ري ده 


